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Introduction 
 

Hello, my name is Steven Schneiderman, and I’d like to show you a quick and 
easy way to electronically publish your work within minutes. In the pages that 
follow, you will learn about some of the pros and cons of ebook compilers and 
ebook publishing companies, and why I think EbookoMatic, The Instant Online 
Ebook Publisher, is the only reasonable choice for you to consider. 

I can show you a way to publish your ebooks and begin selling them online on 
multiple web sites within minutes. Not months, weeks, or even days. In fact, if 
your manuscript is in Microsoft Word for Windows 95, 97 or 2000, you could 
be published in the same amount of time it takes you to read this brief ebook! 

Now, I know you're probably skeptical. That's normal and healthy, but here's why 
you should listen to me: I've paid my dues trying to get my own work published, 
and now you can benefit from my experiences. Here's what I've learned. 

• You don’t need an agent or a publisher to sell your own ebook online. Say 
goodbye to needless revisions and rejection forever. 
 

• You don’t need to know anything about PCs or the Internet. If you can 
open a web browser and click on a button, you can publish electronically. 
 

• You don’t need to spend a lot of money on printing and shipping. With 
electronic publishing, there is no inventory management to worry about. 
 

• You don’t need to know anything about HTML coding. Forget about trying 
to turn your manuscript into a massive collection of web pages. 
 

• You don’t need to worry about credit card transactions or web design. Let 
someone else handle this for you. 
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Publishing electronically is much, much easier than you think! 



Publish or Perish 
 

We all know that getting the attention of a publisher, agent, or editor is one of the 
greatest challenges a writer faces. 

Like most writers, I spent time learning to craft the perfect cover letter. I spent 
money duplicating my manuscripts and including self-addressed stamped 
envelopes with every sample of my work. And at the end of several months, if I 
was lucky, I had nothing to show for my efforts except a growing pile of rejection 
letters on my desk. Am I alone? No. I'm sure you have stories of your own. 

Then one day it dawned on me that maybe I was focusing all of my energy on the 
wrong audience. Instead of trying to interest a few select people in power, why 
didn't I just go straight to the people who might want my book in the first place? 

Just because those publishers, agents and editors didn't show an interest in my 
work didn't mean that there weren't potentially millions of people out there who 
would read it! And what better way to reach those millions of people than through 
electronic publishing? 

Ever since Stephen King hit the cover of Time Magazine last year, ebooks have 
been the center of attention amongst authors and publishers. Frankly, ebooks 
have been around a long, long time – almost since the Internet went commercial 
in 1995 – but to the bulk of the people out there, it was a new, untested medium.  

When King decided to release his book via the Internet, all eyes turned towards 
him, and many publishers wanted him to fail. In the long run, while King made 
about $500K in his first month, he opted to discontinue his online serialization of 
his novel in favor of print publishing. He knows who butters his bread. Still, for the 
vast majority of previously unpublished authors, electronic publishing has huge 
benefits: 

• You don’t need an agent or a publisher. 
• You can create an ebook yourself using tools like EbookoMatic. 
• You can automate ordering and fulfillment. 
• You can give your ebook exposure to millions of readers for free. 
• You can receive greater financial rewards. 
• You can bring your book to market instantly. 
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These are all good reasons to publish your work electronically. The challenge 
has been how to bring your ebook to market quickly, affordably and securely. 



Decisions, Decisions, Decisions 
 

Once I decided to publish electronically, I realized I had to make a decision. Did I 
want to purchase ebook software, create my own ebook, and then develop and 
promote my own web site, or did I want to find a trustworthy electronic publisher 
to manually convert my manuscript and then promote it for me? 

Now I have looked at just about every major ebook compiler package on the 
market. In fact, I presently own over 15 different software packages including 
several that are freeware and shareware products. Here's what I found: 

• Some software can cost in excess of $250. That’s for starters. Then you 
have to consider the cost of your time to learn how to use the software. 
This usually results in lost time and money and a great deal of frustration. 
 

• Some companies charge you to upgrade every time they release a new 
version of their software, and if you don’t upgrade they won’t support your 
old version. So you have an ongoing investment to worry about. 
 

• Some software can actually promote piracy by storing your web pages in 
temporary directories enabling anyone to alter, copy, print and resell your 
ebook without you even knowing about it. 
 

• Some software requires you to have an understanding of HTML coding 
and sophisticated web page design. While many folks dabble in creating 
their own web pages, few of us are talented enough technically or 
graphically to create a smart looking finished product. 
 

• Freeware and shareware ebook compiler solutions may appear to have 
good value, but sometimes they can be buggy, poorly supported, and 
limited in their functionality. Many also use their own proprietary format 
that can cause all sorts of support problems further on down the road. 
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So much for ebook compilation software. I don't know about you, but I'd rather 
spend my time writing and working on new books. If you have the time and 
money to experiment, more power to you. But if you want to focus more time on 
your writing, please read on. 



Same Challenges, Different Medium 
 

I've also performed thorough research about ebook publishing companies, too. 
One search through your favorite search engine will reveal hundreds of ebook 
publishers. Who are these people and where did they suddenly all come from?  

Most are folks just like you except that they have found the time to master ebook 
software compilation and web design. Many of these “techies” have built a small 
business by charging authors like us anywhere between $50 to over $1000 to 
manually convert a single manuscript into an ebook. That’s a lot of cash for 
anyone to spend, especially a fledgling author. 

Like many of the small press publishers in the print world, many of these smaller 
electronic publishers are also going out of business faster than you can say "dot 
com." In fact, some of the forerunners of ebook publishing went belly up in just 
the past few months claiming insufficient funds and lack of profitability. Do you 
really want to see your publisher go under before your ebook even has the 
chance to see the light of day? I don’t. 

There are some larger, more recognized publishers who are attempting to make 
the transition from print to ebooks. Some are buying up the failing dot coms, but 
it’s clear from visiting many of their web sites that they don’t fully understand the 
ebook market or the needs of the authors.  

They don’t understand that new authors frequently want greater control and 
participation in how their work is marketed, and that the old way of doing 
business (low royalties) is no longer favorable.  

Of course, the really big problem with trying to approach a major publisher is that 
they tend to publish established authors with a successful track record over new 
authors.  
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Big surprise.  



There’s Got To Be A Better Way 
 

With many electronic publishing services, you're often just another ebook on a 
virtual ebook shelf. Sure, you have the satisfaction of knowing your ebook is 
available for sale to millions of people, but a part of you feels powerless.  

Why? Possibly because without knowledge and experience in Internet-based 
marketing and promotion, no one is going to find out your ebook even exists. 
While a lot of these online publishers might have real pretty web sites, if folks 
don't know your ebook is there, how will they ever find you? And while some of 
these publishers might offer the latest print-on-demand technologies, they usually 
know little to nothing about marketing and promotion. 

EbookoMatic is different. It enables authors like you to publish electronically, 
and it provides all of the tools necessary for you to promote your ebook on the 
Internet yourself. When you join EbookoMatic, you'll be putting the power of the 
latest technology and the best marketing practices to work for you with just a few 
clicks of a button: 

• Click to upload your Microsoft Word file. 
• Click to set your password and security settings. 
• Click to fill in your Ebook Summary. 
• Click to upload an ebook cover graphic. 
• Click to fill in your Author Page. 
• Click to upload a photo of yourself.  

And you're done. Your ebook is now online and available for sale in both 
EbookoMatic's Library and the BuyMyEbook.com bookstore on your very own 
personalized web page. What could be easier than that? 

Once your ebook is online, you can sign-up for your free promotional email 
address. Next, you can use the free Online Press Release Generator to create 
a professionally written press release within minutes. Email it to your friends, 
family, peers, local papers, etc. Read about the most successful marketing and 
promotion tools, services and strategies in the Members Only reference area 
containing over 2000 pages of free, useful information.  
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If you apply a little energy to your promotion, soon folks will be reading more 
about your ebook to buy copies of their own. 



Is EbookoMatic Right for You? 

 

Now EbookoMatic may not be for everyone. You'll need to have your manuscript 
ready for publication in either Microsoft Word for Windows 95, 97, or 2000 (no 
Macintosh files, please). While the conversion engine we utilize is capable of 
converting over 250 file formats to secure Adobe Acrobat files, we have found 
that these newer versions of Microsoft Word for Windows work the best.  

If you have your manuscript written in an older version of Microsoft Word, 
Microsoft Works, or another word processor package we might be able to 
manually convert it for you for a nominal charge. However, these types of 
conversions tend to be challenging and time-consuming, and unlike our more 
costly competitors, we’re not in the manual file conversion business. 

If your manuscript needs some fine-tuning, proofreading, or even conversion to 
an acceptable format, we recommend the services of companies who specialize 
in these types of services like ManuscriptEditing.com or Adverbage.com. 

We prefer to work with authors who use Microsoft Word for Windows 95, 97, 
or 2000 and who are ready to publish right away. Is that you? 

 

We also highly recommend that you use Internet Explorer 5.5 with Java-
enabled to view and use EbookoMatic. While you can view our web pages with 
Netscape 4.06, Opera 5.0, AOL 5.0 or higher, some of our features may not be 
fully accessible with these other browsers. 

Recommended Tools and Services: 

• Microsoft Word 2000 
• Internet Explorer 5.5 
• ManuscriptEditing.com 
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• Adverbage.com 

http://www.manuscriptediting.com/
http://www.adverbage.com/
http://www.beyond.com/AF11589/PKIN053435/prod.htm
http://explorer.msn.com/
http://www.manuscriptediting.com/
http://www.adverbage.com/


Testimonials 
 

 

Ken Silver 
eBook Secrets 

"I've seen quite a few ebook compilers, but 
none of them appear to be as simple to use 
as EbookoMatic. All you need is a 
Microsoft Word file, and EbookoMatic 
puts it all together for you in minutes. What 
could be easier!" 

 

 

 

Rhoda Hamblin 
You'll Never Be The Man Your 

Mother Was 

"Ebooks are the future and EbookoMatic 
makes it possible now. Publishing my ebook 
was an enjoyable and educational 
experience. My advice? Don't put off 
tomorrow what you can do right now." 

 

 

Warren Brown 
What Happened In Fool the 

Eye 

"EbookoMatic is a straightforward and 
effective way to get your ebook published. 
For writers who prefer to spend their time 
writing rather than designing web pages and 
learning ebook compiler software, 
EbookoMatic provides an economical, 
innovative, and feature-rich solution." 
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Ebook Publisher Checklist 
 

� #1: Make sure you can publish quickly and easily. 
With EbookoMatic you just click a few buttons, and your manuscript is 
uploaded, converted, secured and ready for sale on multiple web sites 
within minutes. You should not need a computer degree to publish your 
work, and there is nothing faster or easier available on the Internet today. 
 

� #2: Make sure you retain your electronic rights.  
With EbookoMatic, you retain the rights to your ebook at all times. In fact, 
we give you total control over how your ebook is represented on the Net. 
You write and design your own Author's Page, Ebook Summaries, and 
you can even add your own cover graphic and author photo. And you may 
edit and change these as often as you like, whenever you like, at no 
additional charge. This puts you in control of your ebook and your 
message. Test and fine-tune it until you get it just right. 
 

� #3: Make sure you earn the highest royalties possible. 
With EbookoMatic, we believe in low membership fees and high royalties. 
We pay our authors 75% of their ebook sales minus small transaction 
costs to cover credit card processing. And, we provide our authors with 
real-time stats of the number of times someone has viewed your Author 
Page and purchased your ebook. 
 

� #4: Make sure your solution helps you to build a relationship with 
your readers. 
With EbookoMatic, every time you make a sale, you get instant email 
notification, and we provide you with the email address of the person 
who bought your ebook. This enables you to build your own follow-up list, 
to drop them an email to see how they liked your ebook, and to let them 
know when your next ebook has been published. 
 

� #5: Make sure you get maximum value with your solution. 
EbookoMatic features a Members Only reference area with over 2000 
pages of FREE marketing and promotion tips, advice, tools, ebooks, 
tutorials and courses available online 24 hours a day. Download all you 
want! 
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� #6: Make sure you get a full money-back guarantee. 
With EbookoMatic, all we ask is that you use our system for 30 days, 
upload a manuscript, convert it, and put it up for sale in our Library. 
Download your FREE bonuses. Now you may not sell your first ebook in 
the first 30 days, but if you don't agree that you have received your 
money's worth -- that no other electronic publisher on the Internet offers 
more value than we do, then we'll give you your money back, and you can 
even keep all of the FREE bonuses. Just fill out our member survey and 
we’ll refund your money 100%. 



Why Do It Yourself? 
 

If you were to try to publish your own ebook by yourself, you'd have to shop for 
the right software, learn it, convert your ebook, find a web host, get a merchant 
account, design a web site, process orders . . . but isn't your time worth more to 
you?  

Wouldn't you rather be writing your next best seller?  

Join EbookoMatic today and you will receive all of the following benefits:  

• You can publish up to three different ebooks 
• You get your own Author Page in our online Library 
• You get your own promotional ebook4sale.com email address 
• You get access to the Online Press Release Generator  
• You receive unlimited access to the Members Only reference area 

featuring over 2000 pages of marketing and promotional material, free 
tools and much, much more 

And there’s more . . .  
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Your Ebooks Are Available On Multiple Web Sites 
Realizing that exposure is key to an author, we have begun to turn up multiple 
websites focused on the ebooks of our members. When you publish your ebook 
with Ebookomatic, it is automatically placed into the libraries and bookstores of 
all of our sites.  

 

The EbookoMatic Library 
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The BuyMyEbook.com Library 



And each month, we highlight the works of a single author on The Ebook of the 
Month.com web site: 

 

The EbookoftheMonth.com Site 

While we can’t provide this type of personal exposure for everyone, we are 
always happy to accommodate our members by setting up simple links to their 
own Author Page to make it easier to promote their own ebooks. 

In addition, we promote all of our web sites monthly including: 

• Top Ten Search Engine and Directory Listings 
• Pay for Placement Search Engine Listings 
• Ezine Classified Ads 
• Cross-links with Targeted Service Providers 
• Promotion Through A Growing List of Targeted Affiliate Web Sites 

Keep your money in your pocket and let us give you the exposure you want. In 
the months ahead, we will be turning up even more sites, some genre specific, to 
give our authors even greater exposure and revenue opportunities. 
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Normally, this would be a good enough reason to publish your work through us, 
but we have arranged several significant bonuses with your membership . . . 



Bonus #1: Free Pro Shop Ebook Library 
 
Since I know it's 100% to your benefit to act right away, I want to sweeten the pot 
and give you every possible reason to say “YES” right now! If you respond 
immediately, you'll also receive access to all of the following FREE bonuses: 
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These are some of the most popular marketing ebooks available on the Internet 
today. Some of these titles have sold for $25 elsewhere, but they are all yours 
FREE with your membership. And we're always adding more! 



Bonus #2: Free Copy of Autoresponder Magic 

 

Yanik Silver is one of the best direct mail copywriters in the business. His ebook, 
Instant Sales Letters, has sold thousands of copies. Nobody understands direct 
marketing better, and for independent ebook authors, it's all about direct 
marketing through email. 

Autoresponder Magic is his latest 500+ page volume that tells you everything 
you need to know to promote your ebook by email using autoresponder. Email 
autoresponders work like a fax-on-demand system. Maybe you've seen the 
systems where you call from your fax machine and dial a certain code and you'll 
get back a document in your fax machine? Well, an email autoresponder works 
the same way. If you send an email to an autoresponder address you'll get back 
a prewritten message. Until just recently, you could only do a one-time auto 
responder with one message coming back. But now you can set up a whole 
sequence of autoresponder messages going out on any day you choose.  

Autoresponder Magic contains some of the most successful and persuasive 
autoresponder messages ever written. It's jam-packed with autoresponder 
messages that have been proven to work by the top Internet Pros.  

For example, one series written by Declan Dunn has been used successfully for 
over 2 years (and it's on complete autopilot - he doesn't even lift a finger) to sell 
hundreds of thousands of dollars of his products and services. Wouldn't you want 
to get your hands on that autoresponder series? Well, that's just one of winning 
messages in this incredible collection. Each series has been market tested and 
proven to pull in sales by the top Internet marketers. People like…  

• Declan Dunn  
• Terry Dean  
• Ken Evoy  
• Jim Daniels  
• Harmony Major 
• Joe Schroeder  

• Sam Robbins  
• Ken Silver  
• Dale Armin Miller 
• Jonathan Mizel  
• Scott Covert 
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This is a $17.00 value, but it's yours FREE with your membership (and we even 
show you how to get free autoresponders). 



Bonus #3: Free Copy of Ebook Secrets 

 

Ken Silver is known as the guru of ebook marketing, and he's said, "I've seen 
quite a few ebook compilers, but none of them appear to be as simple to use as 
EbookoMatic."  

In his extensive ebook, Ken will show you the methods he used to sell almost 
1000 “how to” manuals on the Internet as well as more than a dozen reprint 
rights totaling in excess of $218,000.00 (New Zealand currency).  

The ebook includes all of the following: 

• 420 pages 
• Detailed color screenshots 
• Step-by-step instructions 
• The free software he uses 
• How to set up your business 
• Writing killer copy 
• Hints and tips from his years of experience 
• Success case studies 
• Huge sample resources of his work 
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This is sold elsewhere on the Internet for $39.00, but it is yours FREE with your 
membership. 



Our Ironclad Money Back Guarantee 
 

 

For a limited time only, 
you get all this and more for only $49.95! 

You can't lose with our 100%, 
ironclad, money back guarantee. 

By the way, these bonuses are yours to keep even in the unlikely event you 
decide to take advantage of our ironclad money back guarantee: 

Your satisfaction is assured through our no risk, you-can't-lose, 100%, no-
questions-asked, ironclad money back guarantee. If for any reason, you aren't 
thrilled and satisfied with our service, just contact us within the first 30 days and 
we'll refund 100% of your purchase price. No hard feelings. 

What I'm saying is, don't decide now if this service is for you. Just sign up and try 
it out. If it doesn't do everything I say and more, if you don't save money, time 
and frustration, if it doesn't work for you, you have nothing to worry about 
because you can get every dime of your money back under our no-loopholes 
guarantee. All we ask is that you fill out a brief survey to help us to improve our 
service for future members.  

Bottom line: You have nothing to lose and everything to gain. 
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Order Now 
And I’ll Double The Number of Ebooks You Can Publish! 

Click the   BUY IT   button on the bottom of this page to get started publishing 
right now! You'll be taken to the EbookoMatic Registration area where you'll be 
able to set-up your account, process your membership fee, and begin publishing 
in minutes (remember, this is a web-based service -- you won't receive any 
software in the mail). 

A charge for $49.95 will appear on your credit card under the name of 
Clickbank/Kinetics, our ecommerce processing partner. Their web site is 
located at www.clickbank.com. 

Thanks for using EbookoMatic. To your publishing success,  

 

Steven Schneiderman 
Founder and CEO 
EbookoMatic 
info@ebookomatic.com 
866-66-EBOOK 

P.S.: I can't guarantee this low entry price forever. Sign-up now and take 
advantage of this price and value before it's too late. You have nothing to lose 
and everything to gain. Click the   BUY IT   button at the bottom of this page to 
get started right now, and then proceed to the next section to help you get started 
publishing.  

P.S.S.: If the price has already increased by the time you download and read this 
ebook, register anyway, and I will rebate the difference via PayPal upon receipt 
of your order! I want you to join and experience the joy of electronic publishing! 

P.S.S.S.: Don’t forget to drop me an email after you register, and I will double the 
number of ebooks you may publish from three to six! 
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Getting Started with EbookoMatic 
 
Once you have made the decision to become a member of our service, you’ll 
want to take the time to insure your manuscript is properly prepared. Now we 
can’t sit beside you and guide you through every facet of Microsoft Word, but if 
you do need help, we’re providing the basics in this ebook to help you find your 
way. Additionally, members have access to our online interactive Microsoft 
Word tutorials for further assistance. Membership does have its benefits! 
 
When you log into our service for the first time, please read Getting Started, and 
News to read about general system navigation and the latest updates to the 
system. Then surf around the Members Only reference area to familiarize 
yourself with the lay of the land, functions and features.  
 
You’ll spend most of your time on the Author Support page that enables you to 
do all of your uploading, editing, and downloading. Online Help is always only a 
mouse click away. We monitor activity on the Author Support page to see if 
folks need help, so don’t be surprised if we page you to see if you have questions 
or need some additional assistance. 
 
Before you actually begin to publish using our system, we need to cover general 
manuscript preparation – the things that you need to do in order for your ebook to 
look polished and professional.  
 
Remember, with EbookoMatic, your end results will look nearly identical to the 
file you submit, so if you have misspelled words, poor punctuation and grammar, 
and a sloppy layout, that’s exactly what your ebook will look like.  
 
So put your best foot forward, put a little extra work into making your manuscript 
shine, and the resulting ebook will look perfect. 
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Pre-Publication Checklist 
 
Before you publish your first ebook with EbookoMatic, we’d like to provide you 
with some general suggestions for preparing your manuscript.  
 
The general rule of thumb is to design your ebook so it can be easily viewed on 
most people’s computer screens. Get a few people's opinions before publishing 
it. If they have no problems reading it, then you'll do fine.  
 
If you have some doubts, then experiment with the look and feel until you have it 
just right. Remember, you get three conversions with your membership, so if you 
don't like the way it looks the first time, just try again! And if you do make a 
mistake or are unhappy with the final product, don’t worry. We’ll delete it from the 
system and let you try again at no additional cost. We’re here to help. 
 
Just follow these helpful tips to get started publishing your first ebook: 
 

• Make sure your work is original.   
• Design a book cover (text is OK).   
• Include a book title and author name in the header. 
• Include page numbers in the footer.  
• Divide the book into chapters if needed.   
• Apply title styles to chapter headings. 
• Include a Table of Contents.   
• Use double line or one and half line spacing.   
• Use easy-to-read standard fonts like 12 point Times Roman or Arial.   
• Limit the use of colored or fancy type except for book titles.   
• Limit the use of unnecessary clipart to make your ebook small in size.   
• Insure you have the rights to reproduce artwork and extended quotations.   
• Include an About the Author page.   
• Include a Copyright notice. 
• Include contact information.   
• Include a Disclaimer page.  
• Include a Credit page for quotes and references to other works.   
• Check spelling, punctuation and grammar three times.   
• Save the file using a descriptive file name.   

Recommended Tools and Services: 
 

• Neil Tarvin’s How To Design A Great Ebook 
• Self Publish At The Speed of Thought 
• Cheap and Easy Guide to Self-Publishing 
• Daily Ebook Marketing Plan 

 
 

Page 22 

 

http://links.verotel.com/cgi-bin/showsite.verotel?vercode=6980:9804000000190529
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Your Ebook Cover 
 
According to most ebook publishers and designers, a well-designed ebook cover 
can increase sales by as much as 300%. If you decide to it yourself, make sure 
you have some artistic abilities first.  
 
VirtuaPack creates stunning, artistic representations of ebook covers – among 
the most sought after graphical design available on the Net. 
 

     
 

         
 

 
 

Recommended Tools and Services: 
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• VirtuaPack Ebook Covers 

http://www.virtuapack.com/click.htm?id=spidy
http://www.virtuapack.com/click.htm?id=spidy


Sample Copyright Notice 
 

Here are some helpful hints and suggestions for insuring your rights for your 
ebook are secure. Be sure to register your ebook with the U.S. Library of 
Congress to fully protect your time and efforts and intellectual property. 
 
Here is a sample Copyright notice that you should include in your ebook: 
 

Copyright (C) 2001. Your Name Goes Here. All rights reserved. 
 
You may also add the following to further protect your rights: 
 

No part of this publication may be reproduced in any form, by 
Photostat, microfilm, xerography, or any other means, which are 
now known, or to be invented, or incorporated into any information 
retrieval system, electronic or mechanical, without the written 
permission of the copyright owner. 
 

John Doe - 111 Main Street - Anyplace, Anywhere 12345 – USA 
YourName@Ebook4Sale.com 

 
If you are giving your ebook away as part of a promotion, you'll want to tell folks 
who receive your ebook that it is free and they should never be charged for it: 
 

This ebook is distributed for free by John Doe. If you believe you 
have been charged for this ebook, please notify the author at 
YourName@Ebook4Sale.com. 

 
When it comes time to actually process your copyright, you have a few 
different choices. You can either pay an attorney or copyright service to 
file your paperwork for you, or you can use software to track and file your 
copyright forms yourself.  

Recommended Tools and Services: 
 

• Click and Copyright 
• Official Copyright Software 
• Free Copyright Ebook from EbookoMatic 
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http://www.loc.gov/copyright/
http://www.loc.gov/copyright/
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http://www.ebookomatic.com/members/property/copyrights.pdf


Sample Disclaimer Notice 
 

Here is a sample disclaimer notice that you should include if your ebook is 
promoting or selling advice or a service that may be used to generate revenue.  
 
Since your readers' results may vary widely, you need to insure that they 
understand that you are not making a legally binding agreement or promise to 
them that they will have the same results as yourself or others.  
 
There is a fine line here between a disclaimer and false advertising, so consult 
an attorney for the most appropriate wording for your particular ebook prior to 
publishing: 
 

This ebook publication is being distributed with the expressed and 
implied understanding that the author and publisher are not 
engaged in rendering legal, accounting, or other professional 
advice.  
 
If legal advice or other expert assistance is required, the services of 
a competent professional should be sought. While the author has 
made every effort to be factual, your results may vary. 
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Using Styles 
 

Adding a Table of Contents in Microsoft Word requires you to do two things: 
add title styles to your chapter headings throughout your document and to use 
the automatic Table of Contents generator to create the contents page. 
 
Styles allow you to highlight text, and with a click, to apply multiple attributes 
simultaneously. In this way, you can set chapter titles as 24 point, bold, Arial, 
centered all with a single mouse click.  
 
Using styles saves a lot of time. You can look at the default style settings for your 
document file by clicking on Format > Style. Your styles may be set-up 
differently than the ones pictured here. 
 

 
Applying Styles 1 

 
To apply a heading style, you simply highlight the text with your cursor, and then 
select Heading 1 (24 point, bold, Arial, centered text) from the drop-down style 
menu that appears on the left side of the top toolbar. 
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Applying Styles 2 
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Applying Styles 3 



Instantly, the highlighted text takes on the attributes of the style selected. In this 
case, Heading 1. 

 

 
Applying Styles 4 

 
You would scroll through your document and apply a Heading 1 style to each 
main chapter title (if you wanted to, you could apply other style settings -- 
Heading 2, Heading 3, etc. -- to various levels of chapter subtitles, but this can 
get confusing for the reader).  
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Adding A Table of Contents 
 
When you have finished adding styles to your chapter titles, you are ready to 
auto-build your Table of Contents. Start by selecting Insert > Indexes and 
Tables from the top menu bar. 
 

 
Building A Table of Contents 1 

The options for Indexes and Tables appear. Click on the tab for Table of 
Contents.  
 
If you have only applied a single heading style to the main chapter headings, 
then make sure the Show Levels settings is set to 1.  
 

Page 29 

Then click on OK to generate your Table of Contents. 



 
 

 
Building A Table of Contents 2 

 
Building A Table of Contents 3 
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If you add or edit chapters, you can regenerate an updated Table of Contents. 
Repeat the process, and Microsoft Word will ask you if you want to “Replace the 
selected table of contents?” Respond with “Yes” and an updated table will be 
created and displayed. 

 

 
Building A Table of Contents 4 
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For ebooks fewer than 25 pages, a Table of Contents is usually not necessary, 
but if you have many chapters and want to be courteous to your readers, add a 
Table of Contents. It’s quick and easy with Microsoft Word. 



Adding Headers 
 
When publishing your manuscript, it is important to make the document look as 
professional, clean and crisp as possible. Adding the Title and Author Name to 
the page header and Page Numbers to the footer really helps your reader as 
they progress through your book. Start by selecting View > Header and Footer.  
 

 
Adding Headers and Footers 1 

Your page will display a rectangular header at the top of your page bordered by 
dashes. Enter your Title and Author Name here. 
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Adding Headers and Footers 2 



Adding Footers 
 
To enter your page numbers in the footer, click on the header/footer toggle 
button on the tool bar, and the page will jump to the bottom of the page and 
display the footer area. Type and center the word “Page” and then click on the 
“#” sign to add auto page numbering to your footer. 
 

 
Adding Headers and Footers 3 

 

 
Adding Headers and Footers 4 
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Uploading Your Word File 
 
Now that your manuscript is ready for publication, let’s look at how easy it is to 
actually upload your file and begin using EbookoMatic. First go to the Member 
Login screen located at http://www.ebookomatic.com/publish/signin.asp and 
enter your login name and password that you chose when you first registered for 
EbookoMatic (if you have forgotten your password, just enter your login name 
and click on Forgot Password, and the system will email you your password 
immediately). Additionally, you can change your login and password at any time. 
 

 
Publishing with EbookoMatic 1 

 
Upon login, you will arrive at the Members Only screen that provides general 
navigation tips and information about the system. To start publishing, click on 
Author Support where you can do all of the following: 
 

• Review checklists 
• View online tutorials 
• Upload and download your ebooks. 
• Create and edit your Ebook Summaries and Author Page. 
• Upload and change your ebook cover and headshot graphics. 
• Download free tools. 
• Check your Page Views and Royalties in real-time. 
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Here’s a snapshot of the Author Support page with all of its options: 
 

 
Publishing with EbookoMatic 2 

 
Look under the Upload section and click on Upload a New Ebook File. Here you 
will browse for the Microsoft Word file located on your PC that you want to 
upload to our system. Then you enter a password that will be required to open 
the ebook. 
 

 
Publishing with EbookoMatic 3 
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With this password and the security settings (see the red arrow) you can prevent 
anyone from performing unauthorized printing, editing, copying and modifying of 
your ebook. By default all of these functions are disabled. 



 

It’s important to remember a few things about security: 
 

• On any given day, a good hacker can crack any software or ebook. But 
remember, if this was a print book, anyone could loan the book to 
someone else, copy pages on a copier, quote your work in their own work, 
etc. 
 

• The odds of someone deliberately editing and reselling your work in an 
authorized fashion are fairly slim. Don’t make yourself neurotic about 
security. Copyright your work prior to publication and you should be able 
to sleep at night. 

 
While your file is being uploaded to EbookoMatic, a box will pop-up in the upper 
left corner of your screen to show your progress, your account status, and the 
number of remaining conversions. 
 

 
Publishing with EbookoMatic 4 
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Preparing Your Ebook Summary 
 
After your file has been received and conversion has begun, the system will 
prompt you to fill in an online form for your Ebook Summary. Here you may 
choose the status of the ebook, the price, the ebook title and the genre.  
 
Your ebook status may be set to any of the following: 
 

• Available for Sale Online 
• Available for Free Download (great for offering free excerpts) 
• Not for Public Use (great for personal documents or works in progress) 

 
Our genre choices are numerous, but if you can’t find an appropriate genre, you 
can even add your own!  
 
None of these settings are in stone, and in fact, may be changed at will through 
Author Support. So if your ebook is not selling well at $10.00, you can always 
reset the price to $8.95. 
 
Here are some snapshots of the Enter Ebook Summary screen where you can 
choose these settings as well as include a brief summary and book excerpt. 

 

 
Publishing with EbookoMatic 5 

Page 37 

 



Note the Ebook Summary screen is comprised of two parts. The lower portion of 
the screen allows you to enter a textual description of the ebook. 

 

 
Publishing with EbookoMatic 6 

 
It’s really important to use this summary space wisely. Describe your ebook 
concisely and include a few paragraphs or the first page of your book. This is 
your best chance to intrigue new readers and customers. 
 
A carefully crafted Ebook Summary will help you to sell your ebook. Blurbs and 
summaries attract people’s attention to your work by intriguing them with details 
about your story.  
 
If you describe your ebook with dry, non-descript words and phrases, the 
chances are people will ignore your ebook. However, if you write a summary that 
stimulates their imagination, you will hook them, and they will buy your ebook. 
 
Writing a summary that sells is very different from creative or academic or 
technical writing with which most authors are familiar. To that end, it is to your 
benefit to read a little bit about copywriting. 
 
There are many books and courses available on the subject. Some of the best 
are distributed through Dr. Ken Evoy who is among the highest respected 
marketers on the Internet today.  
 
His extensive collection of ebooks covers everything including how to write text 
for your web site, how to transform your knowledge and experience into revenue, 
how to determine the appropriate price for your products and services, and how 
to choose the most powerful words to help sell your work. We recommend his 
ebooks highly.  
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To get started, we recommend signing up for his free mini-courses available by 
email. Each day you’ll receive helpful hints and examples about how to write well 
for the web. 

Recommend Tools and Services: 
• Make Your Site Sell 
• Make Your Knowledge Sell 
• Make Your Price Sell 
• Make Your Words Sell 
• The Netwriting Master Course 
• The Pricing Master Course 
• The InfoProduct Master Course 
• Instant Sales Letters 
• Push Button Sales Letters 
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Uploading Your Ebook Cover Graphic 
 

After submitting your Ebook Summary, the system prompts you to Upload Your 
Graphic File. Here you may upload an ebook cover graphic you’ve designed or 
had designed for you. All you do is browse for the appropriate file and click to 
upload it to our system. 

 

 
Publishing with EbookoMatic 7 

 
The graphic upload usually takes only a few seconds due to the small size of the 
graphic file. Remember to make sure you’ve sized it appropriately prior to 
uploading (100 x 100 pixels) and that the file is in either JPG or GIF format.  
 

 
Generic Ebook Graphic (100 x 100 pixels) 
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If you don’t have a cover graphic at this time, no problem; the system will assign 
the generic graphic pictured above. You can always upload a cover graphic later, 
or change them frequently to test market reader response. 



Preparing Your Author Page 
 
Just as your Ebook Summary sells your ebook, your Author Page sells you to 
your readers. It’s very important to blow your own horn in moderation. That is to 
say, you want to impress your readers, but at the same time, you do not want to 
come across as one who lacks all humility. 
 

 
Publishing with EbookoMatic 8 

 
As an exercise you might list the top ten facts you want to include on your 
Author Page, and then write the page in the third person as if you were an 
interviewer or an objective third party. 
 
Most Author Pages include the following information: 
 

• Year and place of birth 
• Educational background 
• Past publications 
• Past awards or accomplishments 
• Current information 

 
An example might be as follows: 
 

“Steven Schneiderman was born in the Bronx, NY in 1958. He has 
earned both a B.A. and an M.A. In Creative Writing, and he has 
taught English as a Second Language at Queens College, The City 
University of New York in the early 1980's. 
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His previous poetry has appeared in numerous small presses 
across the country including Poetry Now, Non Sequitor, Drum, 
Terrible Beauty, and Japanophile. His non-fiction work has 



appeared alongside Woody Allen and Stephen King's essays in 
American Voices published by Harper & Row. 
 
His poetry and fiction have won multiple university awards including 
the Schoenstein Award for Versatility in Creative Writing and the 
Kreuzer Award for Most Promising Poet of the Year (1980 and 
1981 respectively) from the City University of New York. 
 
Steven Schneiderman currently resides in Tulsa, OK with his wife 
and two children. In addition to being an author, he is also the 
creator and founder of EbookoMatic: The Instant Online Ebook 
Publisher.” 
 

Like your Ebook Summary, you can also upload a headshot photo of 
yourself for your Author Page. Yes, this means your ebook cover graphic 
shows up in our online library (to help differentiate you from another 
author), and your headshot shows up on the top of Author Page to make 
the make more warm and personal.  
 
To upload a headshot photo, just return to Author Support and choose 
Upload Author photo. The system will walk you through the same process 
as it did before for the ebook cover graphic. Nothing could be simpler. 
 
The snapshot below shows you a sample Author Page in our library. 
 

 
Publishing with EbookoMatic 9 
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Graphic Tips 
 
Graphic files must be in either JPG or GIF format, and they should be sized 
properly for our web pages before you upload them to our system. We accept 
graphics measuring 100 x 100 pixels. We provide a free trial download of a 
wonderful little tool from Trivista called A Smaller Image to help you. 
 

 
Using A Smaller Image 1 

 
Open the desired file, and set the picture size to 100 x 100 pixels (Step 1). Move 
the “Crop Window Slider” over the image to frame it just right (Step 2). Click and 
save. 
 

 
Using A Smaller Image 2 
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Once your graphics are ready, you can upload them to your Ebook Summary 
and Author Page.  



Downloading Your Ebooks 
 
We know that you may want to distribute some free copies of your ebook to 
friends, family and interested parties. We also have many authors who host their 
own web site and wish to offer an excerpt of their ebook for download from their 
own web site. 
 
You may download your ebooks anytime. From Author Support, click on 
Download Ebooks. 
 

 
Publishing with EbookoMatic 10 

 
You will be presented with a bulleted list of ebooks you have published. Simply 
left click on the desired ebook link, and when prompted by your browser, Save 
As to your PC’s own hard drive. Be sure to note where you are saving the file 
and what you called it, so you can easily retrieve it later. 
 
Remember, when distributing your ebooks yourself, you’ll need to include the 
password so people can open and read the file. If you ever forget your ebook 
password, just drop us an email and we’ll send you the password right away. 
 
You’ll also need to provide access to the FREE Adobe Acrobat Reader. Click the 
button below to download a copy now or visit http://www.Adobe.com.  
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Checking Page Views and Royalties 
 
As a value-added service to our members, we provide real-time statistics 
displaying the number of times each ebook summary has been viewed and how 
many sales you have made per ebook. 
 
From the Author Support page, simply click on Royalties and you’ll be taken to 
a tabular display which shows your ebook titles on the left side followed by the 
number of times the summary has been viewed, the number of downloads, and 
the running total for revenues. 
 

 
Publishing with EbookoMatic 11 

 
In addition to being handy for checking your popularity and sales, this is also a 
great marketing tool. If your views and sales are not what you expected than try 
adding or changing your ebook cover graphics or making your ebook summary 
descriptions more intriguing and “salesy”. Then after allowing a few weeks, check 
your statistics again to see if the changes improved your views and sales. If your 
views improved but your sales did not, try reducing your ebook price a few 
dollars, and then give it a few more weeks. 
 
It’s difficult to create and publish a runaway best seller and to make millions of 
dollars from any book sales, but isn’t it nice to know that EbookoMatic is there to 
help you in your efforts? 
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Post-Publication Checklist 
 
After your ebook has been converted, and your Ebook Summary and Author 
Page has been completed and added to our online Library, consider the following 
tips to promote your book in the best possible light: 
 

• Carefully target your audience.   
• Gather testimonials and endorsements from early readers.   
• Finalize your price strategy.   
• Use the Online Press Release Generator to craft the perfect press 

release.   
• Be sure to direct people to your Author's Page in our Library.   
• Send out your press release using our free @Ebook4Sale.com 

promotional email system.   
• Follow-up with customers to insure their satisfaction.  
• Gather feedback for future enhancements to the next edition of your 

ebook. 

Recommended Tools and Services: 
 

• Ebook Submit 
• Ezine Ad System 
• Classified Ad Secrets 
• Free Classified Ad 
• Cool Tool Awards 
• Marketing Weapons 
• Promotional Assistance 
• Advertising Assistance 
• Marketing Assistance 
• Web Design Assistance 
• Aweber Autoresponders 
• Get Response Autoresponders 
• PromoMinder 
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Sample Press Release 
 
Writing a press release is easy, but writing a good one is not. There are two 
simple rules to remember: 
 

• A press release’s job is to inform not sell (make it newsworthy) 
• Press releases follow the same basic format (don’t be inventive) 

 
Here is a sample press release for you to follow: 
 
For Immediate Release  

Tulsa, OK - January 1, 2000 

EbookoMatic.com, The Instant Online Ebook Publisher today announced the release of a new 
ebook entitled Sante Fe Rose written by Posey Gaines.  

"We are very excited to be offering this work written by Posey Gaines, and we feel Santa Fe 
Rose will become a very popular ebook title in the fiction section of our online ebook library," said 
Steven Schneiderman, founder of Ebookomatic.  

"With talent, experience, and a unique voice of his own, we are confident that Posey Gaines will 
come to be highly regarded within the ebook publishing world. We are very proud to have this 
author as a member of our growing online community of writers." 

Santa Fe Rose is Gaines' first book and was written over the course of two years, shortly after 
the loss of his wife to breast cancer in 1993. This partially autobiographical novel is Gaines’ first 
literary work, and part of a proposed trilogy to be completed in the near future. 

Posey Gaines was born in Terre Haute, Indiana, and later settled in Tulsa, OK in 1968. Having 
earned a Masters Degree of Divinity, Gaines worked for the United Methodist Church for 26 
years.  
 
Originally starting as a watercolor artist, Gaines sought other mediums of artistic expression 
including writing and multimedia. He now works as a web designer for AcmeClick.com. 

Gaines currently lives in Tulsa with his wife, Vicki. 

To arrange an interview with the author, please contact: 

Posey Gaines 
gaines@ebook4sale.com 

* * * * 

Recommended Tools and Services 
• Infacta’s Group Mail 
• PressBlaster 
• PRSubmit 
• Internet Service Bureau 
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• Internet Wire 

http://www.sellshareware.com/ProgramInfo.asp?AfID=2318&PrID=34362
http://www.pressblaster.net/cgi-bin/pb.cgi?ID8906
http://www.prsubmit.com/cgi-bin/comcart/redeem.pl?aff=pr120
http://www.commission-junction.com/track/track.dll?AID=799256&PID=263874&URL=http%3A%2F%2Fwww%2Einternetnewsbureau%2Ecom
http://www1.internetwire.com/iwire/affiliates?affcode=74137100973


Online Help 
 

If you ever have a question or forget how to use our service, we offer an 
extensive online Help that is available from every screen throughout the system. 
 
If you can’t find your answer there, try our online FAQ that is posted here: 
 

http://www.ebookomatic.com/faq/faq.htm 
 
Lastly, if you have an emergency, you can drop us an email at: 
 

help@ebookomatic.com 
 
Or you may call us toll-free: 
 

866-66-EBOOK 
 
Our support hours are Monday through Friday, 9:00 am to 5:00 pm, Central 
Standard Time. 
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Members Only Reference Area 
 
As part of your membership, you receive 24 hour a day, unlimited access to the 
Members Only Reference Area. This area is comprised of close to 2000 pages 
of marketing and promotion tips and advice and includes free ebooks, tutorials, 
software, discounts on services, and much, much more. Here’s a brief list of what 
is currently online: 
 
• Intellectual Property: 

o Copyrights 
o Trademarks 
o ISBN Numbers 
o Recommended Links 

• Web Site Design: 
o Words 
o Design 
o Getting Traffic 
o Customer Service 
o Domain Names 
o Web Site Hosting 
o Ecommerce 

• Promotions: 
o Ebook Design 
o Ebook Covers 
o Affiliate Strategies 
o Press Releases 
o Seminars/Readings 
o Mail Campaigns 
o Email Campaigns 
o Recommended Tools 

• Other Formats: 
o Glassbook Reader 
o Microsoft Reader 
o Palm Tools 
o HTML Tools 
o Translation Tools 

• Ebook Pro Shop: 
o Top Ten Ebooks 
o Free Courses and Ebooks 
o Member Discounts 

 
This also includes real-time daily news feeds about writing, ebooks and 
publishing, contests, and free tools that we add monthly. All told, there are over 
2000 pages of material – all FREE with your membership. 
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Make Money With EbookoMatic 
 
If you know other writers who might benefit from our service, you can earn 25% 
commissions if you refer them to our site and they join. How? Simple. Join our 
FREE affiliate program. 
 
Once you become a member, you will have access to a wonderful affiliate 
support web site filled with free banners, ads, web pages, tools and courses to 
help you sell our service.  
 
Sell it by word of mouth, by email, through letters to friends. Just be sure your 
friends use your affiliate link when they sign-up for our service, and you’ll begin to 
earn 25% commissions. 
 
Join our affiliate program today, and make some money while you help others to 
get published. What could be better?  
 
Learn more here: 
 

Page 50 

http://www.ebookomatic.com/affiliates/affiliates.htm 

http://www.ebookomatic.com/affiliates/affiliates.htm


About The Founder 
 

 

Steven Schneiderman was born in the Bronx, NY in 1958. He has earned both a 
B.A. and an M.A. In Creative Writing, and he has taught English as a Second 
Language at Queens College, The City University of New York in the early 
1980's. 

His previous poetry has appeared in numerous small presses across the country 
including Poetry Now, Non Sequitor, Drum, Terrible Beauty, and Japanophile. 
His non-fiction work has appeared alongside Woody Allen and Stephen King's 
essays in American Voices published by Harper & Row. 

His poetry and fiction have won multiple university awards including the 
Schoenstein Award for Versatility in Creative Writing and the Kreuzer Award for 
Most Promising Poet of the Year (1980 and 1981 respectively) from the City 
University of New York. 

Steven Schneiderman currently resides in Tulsa, OK with his wife and two 
children. In his spare time, he writes about the art of magic on his web site, The 
Magic Portal (www.m-a-g-i-c.com), and in a bi-monthly column for GENII: The 
Conjuror's Magazine. 
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Steven is also the principal of Schneiderman & Associates, LLC, Internet 
marketing and business development specialists, and he is the creator and 
founder of EbookoMatic: The Instant Online Ebook Publisher. 

http://www.m-a-g-i-c.com/


 
 
 

About This Ebook 
 
This ebook was published using EbookomaticTM  -- the Instant Online Ebook 
Publisher available at http://www.EbookoMatic.com. 
 
EbookoMatic.com was launched in Q3/2000. The web site enables authors to 
instantly publish and sell their ebooks online. Authors upload existing Microsoft 
Word documents to the EbookoMatic web site where they are instantly 
converted into secure Adobe Acrobat PDF files. These ebooks are then 
distributed and sold across multiple web sites including EbookoMatic.com and 
BuyMyEbook.com. 
 
All EbookoMatic members receive their own Author's Page that they may 
personalize, as well as access to a special Members Only reference area that 
contains over 2000 pages of marketing and promotion advice, ebooks, and tools. 
 
For more information, please contact: 
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Steven Schneiderman 
Founder 
Schneiderman & Associates, LLC 
3504 E. 99 Street 
Tulsa, OK 74137 
866-66-EBOOK 
 
info@ebookomatic.com 
www.EbookoMatic.com 

http://www.ebookomatic.com/
http://www.schneiderman.net/
mailto:info@schneiderman.net
http://www.publishingassistance.com/
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